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Abstract 

This project educates students in the field of classic and modern cryptography and 

the according cryptanalysis, specifically in relation to their use over networks.  The 

project explores the software CrypTool extensively and comprises of a set of three 

one hour lab sheets as well as an accompanying report. 

 

Version 1.1 was updated to make use of the educational software CrypTool 1.4.10.  

Many thanks to Bernhard Esslinger (head of the CrypTool open source project) for 

proof reading this report.
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Preface 

This document was originally written as a final year university dissertation for the 

University of Portsmouth, it has since been updated to reflect the present version of 

CrypTool. 

For this version of this document (version 1.1), extra sections have been included 

and some have been omitted so as it better fits the purpose of educating people in 

how to use CrypTool, and tries to move away from being a piece of course work to 

gain marks. I hope you find it beneficial. 
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REPORT 

1.0 Summary 

Problem 

Students entering employment in computing, telecommunications or other relevant 

technological industries, often require a high degree of knowledge concerning 

network security. One of the most significant aspects of this area is cryptography 

and so it is particularly important that people are educated in this field. 

Solution 

To tackle this lack of knowledge and educate students in the field of cryptography 

this document will include three lab sessions that focus on teaching students the 

subject by using the software package CrypTool. CrypTool is a freely available 

program that allows users to implement and experiment with various cryptographic 

techniques in a user friendly manner. Further details of this software are found later 

on in this document. Accompanying these lab sessions will be an extensive report 

outlining the various aspects of this topic: 

 Relevant theory 

 Techniques used 

 The mathematics behind each technique 

 Strengths and weaknesses of methods 

 Where cryptography is used 

 Cryptanalysis 
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Glossary of terms  

 

Plaintext A message void of any encryption, either prior to been 

enciphered or after been successfully deciphered.  

Ciphertext  Once a plaintext message has been encrypted so that it is 

unintelligible to those without the required knowledge to 

decipher it, it becomes ciphertext. 

Encryption  The process of converting plaintext to ciphertext  

Decryption  The inverse of encryption, converting ciphertext to plaintext.  

Cipher  A technique or algorithm used to encrypt and decrypt data.  

Symmetric key  This method of key management is the conventional method 

used, it refers to both the sender and recipient having the same 

key to encrypt data at one end and then decrypt at the other.  

Asymmetric key  Conversely to the symmetric key system, asymmetric key 

systems use different keys for the sending and receiving of data, 

an example of this is any public key system. 

Stream ciphers  Characters of plaintext are encrypted individually to derive their 

ciphertext. 

Block ciphers Characters are encrypted in groups known as a block, these 

correspond to a block of ciphertext. 

Digram  Is the name given to a pair of either characters or words that are 

to be encrypted together as apposed to individually as they would 

be conventionally. (Some times referred to as a bigram). 

Trigram  Like the digram, the trigram refers to encrypting groups of 

characters or words, but instead works with three instead of two.  

Cryptanalysis The art of obtaining plaintext from ciphertext without the 

intended prior knowledge, such as a key. This covers a large 

spectrum of topics and is similar to the concept of hacking or 

cracking. 

Cryptanalyst One who involves himselve with the art of cryptanalysis. 
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1.1 Introduction 

Often quoted as a revolution, the Internet is arguably the most significant 

development in world history since the moon landings! It is no longer an esoteric 

platform used solely by the military, choice universities and the elite scientific 

communities; it has now become an international medium used by people and 

companies from all over the world.  In fact it has become so popular that the existing 

naming convention, IPv4, which allows for in excess of four billion unique 

addresses, has to be vastly extended and restructured by upgrading to IPv6.  

 

This massive scale use of computer networks means that people from all walks of 

life can communicate with each other around the world, and inevitably, some of 

those people will not want to use the Internet with benign intent. There are several 

circumstances in which one may require information they send over a network to be 

kept confidential. For example a bank transaction, health complications, a personal 

message etc. There are several reasons someone, a cryptanalyst, might want 

possession of confidential details, such motives could include personal financial 

gain, blackmail or general curiosity. Consequently, network security is a vital topic 

in the modern day and so these attack methods should be explored further.  

 

Man-in-the-middle attack 

One of the more prominent forms of attack used is the man in the middle attack, this 

is where messages been transmitted from one computer to another are intercepted by 

a third party. The third party then sends on the packets after reading them to the 

destination machine, sometimes altering their contents. This form of at tack is 

relatively easy to implement yet extremely hard to prevent. To enforce there are no 

wiretaps would require physical security at every point surrounding a wire. In the 

advent of Wi-Fi technology becoming a mainstream platform, prevention of attacks 

at the physical layer have become even harder to prevent . With Wi-Fi networks the 

intruder would only have to get in the varsity of a target to intercept messages.  
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Fig 1: Computer C is intercepting packets intended for Computer B and retransmitting 

them 

 

While every care should be taken to prevent interception of information over a 

network, it is almost impossible to ensure prevention in practice. It is therefore 

essential, that the necessary precautions are taken to hide data should it be 

intercepted. The art of hiding data for this purpose is known as cryptography. 

 

 

“It is insufficient to protect ourselves with laws . We must protect ourselves with 

mathematics.”  

- Bruce Schneier [Schn95] 
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1.2 What is Cryptography 

The word cryptography is derived from the Greek words for “hidden writing”, and 

can be used to describe the concealing of data so as it becomes “esoteric”. 

 

 

“Cryptography – A secret manner of writing, either by arbitrary characters, by using 

letters or characters in other than their ordinary sense, or by other methods 

intelligible only to those possessing the key; also anything written in this way. 

Generally, the art of writing or solving ciphers.”  

 

- Oxford English Dictionary: http://dictionary.oed.com 

  

Principles of cryptography 

Dr. Auguste Kerckhoffs (1835 -1903) was a Dutch Professor of languages and an 

important figure in the field of cryptography. Of the many rules he developed there 

is one that is of particular significance, and so, has been named “Kerckhoffs‟ 

principle”, it states: 

 

 

“All algorithms must be public; only the keys are secret .” 

- Dr. Auguste Kerckhoffs [Augu83] 

  

This has since been reiterated by Claude Shannon, a prominent computer theorist, as 

"the enemy knows the system". The ethos behind the principle is that when making a 

cipher it should be assumed that a cryptanalyst knows its workings intrinsically, that 

is to say the algorithm should be mathematically sound, allowing decryption only 

with the appropriate authentication, whether it be a key, required knowledge or some 

other method. The authors Fred Piper and Sean Murphy [PipMur02] also make 

reference to this same concept and elaborate by breaking down the concept into three 

“Worst Case Scenarios”: 
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1. The cryptanalyst has a complete knowledge of the cipher system. 

2. The cryptanalyst has obtained a considerable amount of ciphertext . 

3. The cryptanalyst knows the plaintext equivalent of a certain amount of the 

ciphertext. 

- Cryptography, a very short introduction [PipMur02, p. 11] 

 

The attitude of opening a security techniques algorithm to the public has meant that 

network security has become a viable option for the public, instead of an asset only 

available to government and military. It also means that there are a far greater 

numbers of people able to analyse ciphers and become cryptanalysts, as there will 

inevitably be people with ill intent. This means that all ciphers must now be written 

with even greater care and accuracy, thus increasing the pressure for their effective 

design. 

 

In addition to this principle, there have been many other concepts described by 

various other significant figures that have played an invaluable role in producing 

secure ciphers. Claude Shannon, was quoted by Bell Labs as "the father of 

information theory", and like Kerckhoffs played a central role in development of 

cipher principles. One of his more notable concepts is that of “confusion and 

diffusion” (from his paper Communication Theory of Secrecy Systems, [Shan49]). 

Confusion is the belief that the transition between plaintext and ciphertext should be 

as complex as possible so as to confuse cryptanalysts. Diffusion is the idea that every 

bit of the output material should depend on as many bits of the input material as 

possible. 

 

The diffusion principle has since been elaborated upon and described as the 

avalanche effect, specifically the belief of this concept is that a small modification 

to the input material should have a dramatic effect on the output material. This is 

especially apparent with hash functions, which are discussed later in this document. 

 

Finally, the trapdoor principle is a metaphor that compares the encryption process to 

falling through a trapdoor. This concept suggests a function should be very fast in 
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one direction, encryption, and very slow, if not impossible, in the other direction, 

decryption, without the appropriate key. 

 

Although not every cipher is able to keep with each of these paradigms rigidly all of 

the time, they offer a sound foundation ciphers may build on. And so each principle 

has, in its own way, improved the overall security of computer networks. 
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1.3 Cryptanalysis 

Whereas cryptography is the art of hiding data to make it secret, cryptanalysis is the 

art of revealing that data without the authors intention. Generally, cryptanalysis is 

considered a black hat art, one which is used with ill intent, although, there are some 

exceptions. One such exception is military intercepting and deciphering a terrorist 

message, such an act of cryptanalysis could save the lives of thousands if not 

millions. Interestingly, it is for this very reason that it is illegal to use a key length 

above a set size for many countries, simply because the government computers 

would not be powerful enough to break such encryption in a practical period of time. 

For further details of encryption restrictions refer to the “Wassenaar Arrangement” 

[Waas08]. 

 

There are many techniques used by cryptanalysts ranging from cipher vulnerabilities 

to social engineering.  Many of there however are specific to the individual cipher 

and will be covered in detail later accompanying the description of each cipher. 

Explained below are some generic forms of attack: 

 

Dictionary attack 

This attack uses a list of words or common character combination (often referred to 

as a dictionary) used to decipher a ciphertext message. The dictionary usually 

comprises of words that are considered most likely to be used as passwords. If it was 

known that the encrypted data belonged to say a German then a German dictionary 

would be appropriate. This technique is fast in comparison to the brute force attack, 

but can still be timely and is not always effective as the password concerned may not 

be included in the dictionary used. 

 

Brute force attack 

The brute force attack, also named an exhaustive key search, is a method tha t tries 

every single possible combination of letters and numbers until the key is found. With 

no parameters the possible key combinations are “infinite”, although several 

algorithms have a specific key size, the possibilities are still enormous. A common 
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key size is 128 bits, as this is at the binary level we can derive the total possibilities 

of this key with a simple calculation: 

2
128

 = 3.40 * 10
38

 

Assuming each decryption attempt takes a computer 1 * 10
-9

 seconds (a 1 Ghz 

machine), it could take up to  

10, 800, 000, 000, 000, 000, 000, 000 years  

to find the key (although the highest probability is always half the maximum time). 

At this point another of Kerckhoffs‟ maxims is relevant:  

 

 

“The system should be, if not theoretically unbreakable, unbreakable in practi ce” 

- Dr. Auguste Kerckhoffs 

 

The vast amount of time required to break a key may suggest that a cipher is secure, 

and although it may be secure at present there is a threat that as computers get faster 

this time will decrease. Another time reducing technique is using a distributed 

system to run the brute force attack, this is where many computers work on the same 

task as a cluster and could vastly reduce the amount of time needed, dependant on 

the number of connected computers.  

 

Rainbow tables 

Another way to reduce the time taken to find a key is to use rainbow tables. 

Although only applicable to hash encryptions, rainbow tables comprise a list of 

every possible precompiled key, or hash, and its corresponding key(s). To decompile 

a hash file then all a cryptanalyst need to do is find the victim hash code in the 

rainbow table and lookup its corresponding key(s).  

 

This is a particular threat to Unix systems where passwords are often stored in an 

easily accessible text file. Although not yet as prevalent as other attacks it is an 

increasing threat. One suggestion to reduce the risk from this form of attack i s to 

regularly change the hash encryption algorithm used or better make full use of the 

optional parameters of the PKCS#5 standard. This would be effective as there is a 



Cryptographic Techniques for Network Security 

 

-17- 

great amount of computer power necessary to create the tables, and only a minute 

amount is necessary for the hash lookup. Consequently taking advantage of PKCS#5 

could mean a cryptanalyst would not have time to create the corresponding rainbow 

table before it is obsolete. 

 

Social engineering 

Social engineering is a term used to describe the art of deceiving a person into 

divulging required information. There are many techniques that can be used and are 

not dissimilar to those used by “con merchants”. A simple example of a technique 

that would fall under the category of social engineering is phoning up a company 

claiming to be the manager and requesting computer login details.  Although this 

example is unlikely to be successful one can see the nature of attacks that fall under 

this category. 
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1.4 History of Cryptography 

Cryptography has a very rich history dating back to ancient civilization . To cover 

this area in full would take the entirety of this paper, instead this chapter comprises 

of a brief timetable covering a selection of the more notable events that have 

occurred over the years.   

 

c. 1900 BC Ancient Egyptians use symbols to represent things, an early form of 

writing. 

c. 1500 BC The Phoenicians develop an alphabet. 

c. 600 BC Palestinians use the Atbash cipher. 

c. 500 BC The Spartans use the encryption process Scytale, a method of 

wrapping text around a cylinder. 

c. 50 BC Julius Caesar uses the Caesar cipher. 

c. 500 to 

1400 AD 

Cryptography is considered a Black art in Europe and so development 

is stunted. Progress still occurs in the field with the Persian 

civilization. 

1466 AD Italian Leon Battista Alberti publishes his book "Modus scribendi in 

ziferas", in which cryptography, specifically polyalphabetic ciphers, 

are discussed for the first time. He is later referred to as the "Father of 

cryptography". 

1585 AD Blaise de Vigenère publishes the book "Tractié de Chiffre" which 

discusses many cryptographic concepts and from which the Vigenère 

cipher was derived.  

c. 1600 to 

1700 AD 

The era of the black chambers began where most governments had a 

department of code breakers. 

1854 AD English mathematician, Charles Babbage breaks the Vigenère's 

autokey cipher and the Vigenère cipher. Also the year the Playfair 

cipher is developed. 

1883 AD "La Cryptographie militaire" published by Auguste Kerckhoffs. 

1917 AD American, Gilbert S. Vernam, develops the one-time-pad. 

1923 AD The German engineer Arthur Scherbius, reveals the Enigma machine. 
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1940 AD Alan Turing breaks the Enigma cipher building on the concepts 

developed by Marian Rejewski. 

1941 AD The Japanese cipher, the Purple machine is broken by a team lead by 

William Frederick Friedman. 

c. 1970 AD The Internet is developed. Although there is no single person 

responsible for the development of the System, Tim Burners-Lee is 

often attributed as been primary developer.  

1973 AD Public key encryption is developed by the British security agency 

GCHQ. 

1976 AD Diffie-Hellman key exchange protocol is developed. 

1977 AD DES is developed by IBM. 

1977 AD RSA is developed. This method is still widely used today. 

1982 AD Richard Feynman develops the theoretical design for Quantum 

Computing. 

1998 AD The DES key is broken using a system called Deep Crack. 

2000 AD AES is chosen as the successor to DES. 

2007 AD A 104 bit WEP key is broken in less than a minute by the University 

of Darmstadt. 

 

 

Further information about cryptography history can be found at www.cryptool.org or 

within the online help of CrypTool. 

http://www.cryptool.org/
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1.5 Mathematical Principles 

Throughout this document, many more or less complex mathematic principles are 

discussed when demonstrating the mechanics behind a cipher. Although it is 

assumed a student has a sufficient mathematical understanding prior to reading this 

document, some of the more advanced concepts are explained below: 

 

Modulus 

Often referred to simply as mod, the modulus is a mathematical operation of great 

importance within computing, especially due to its prevalent use in cryptography. Its 

concern is the resulting remainder when two numbers are divided, based on this the 

modulus is derived. 

 

When two numbers are divided, and there is a remainder, the modulus delivers the 

remainder. This can be demonstrated with the aid of an example:  

 

 

This can be expressed as: 

14 mod 3 = 2 

Alternatively this calculation can be broken down into steps: 

14/3 = 4 R 2.   You get the remainder by calculating 14 – (4*3). 

or 

14/3 = 4.6666666 

Take the functional remainder:  0.6666666 

Multiply it by the denominator: 

0.6666666 * 3 = 2 

14 mod 3 = 2 

This number is 

the remainder. 
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Congruence relation 

Should two numbers produce the same result when modulated with the same number, 

they are said to be congruent. An example is:  

11 mod 3 = 2 

26 mod 3 = 2 

Therefore 11 and 26 have a congruent relationship with respect to the number 3.  

Prime number 

A prime number is an integer which has no integer factors other than itself and 1. 

Examples are 1, 2, 3, 5, 7, 11 etc 

Coprime 

When two integer numbers share no common factors other than 1, they are said to be 

coprime. E.g. 12 and 13 are coprime, 12 and 14 are not as they can both be divided 

by 2. 

Euler totient 

The totient is the number of positive integers less than a given number, n, and that 

are coprime to it. The mathematical symbol for this function is   . An example is 

 , the following numbers were counted: 1, 2, 4, 5, 7, 8 .  
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1.6 Simple Ciphers 

This chapter shall look at the early implementations of cryptography before 

computing came up, as well as the more simple methods used today, pointing out the 

potential strengths and weaknesses of each technique. Although the majority of these 

techniques are seldom used in the present days, they offer a sound foundation of 

theory on which modern ciphers have been built. In order to understand modern 

ciphers it is worth looking at their predecessors and what their weaknesses are .  

Substitution cipher 

A substitution cipher is one in which each character is simply represented by another 

character. There does not have to be any logic to the order of representation however 

some forms of the cipher do have ordering such as the Caesar cipher described later.  

a b c d e f g h i j k l m n o p q r s t u v w x y z 

H X V J D I T U E R G A L S F P W Z M K Q B Y O C N 

The above column shows plaintext characters, the below, a ciphertext representation.  

 

There are however, some inherent weaknesses present within this cipher. One such 

weakness is the vulnerability to statistical analysis. There have been many studies as 

to the statistical prevalence of each letter in the English language and from these we 

can see the likelihood of a particular character occurring in a given sample of text.  
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Fig 2: A comparison of the prevalence of letters 

[The above figures were based on the paper [Lewa00].] 

 

With this information, a cryptanalyst could compare the relative frequency of 

characters within a given ciphertext message to the relative frequency of letters in 

the English language. This can be shown with an example:  

 

The relative frequency of a given ciphertext message (%): 

A 2.4 B 0.9 C 2.8 

D 0.2 E 7.3 F 9.1 

G 2.0 H 1.7 I 6.3 

J 8.3 K 0.1 L 14.1 

M 7.0 N 1.2 O 2.2 

P 2.5 Q 5.8 R 4.5 

S 0.1 T 0.1 U 2.1 

V 0.2 W 6.5 X 6.2 

Y 4.1 Z 2.1   
 

Fig 3: Hypothetical ciphertext relative frequency 
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From this comparison, certain logical assumptions can be made. One observation is 

that the occurrence of the letter L is considerably greater than the occurrence of 

other letters; as such we can assume L represents the letter E. We can then use this 

to piece together more information, say the trigram FIL often reoccurs, we could 

then assume it represents the word the, then compare the statistics to the relative 

frequency of the English language and would see that F and I also match the 

frequency for T and H respectively and so confirm this prediction. In this manner we 

can progress on to deciphering the whole message if it is long enough. It is also 

worth mentioning that the length of the message affects the ease at which a message 

can be deciphered, a long message can often more easily be deciphered than a 

shorter one as there is more information to work with.  

 

The above discussion assumes that the message is written in the English language, 

however the same concept can be applied to any language.  

Caesar cipher 

The Caesar cipher is named so, as it was first implemented by Julius Caesar. It also 

goes by the name of shift cipher and belongs to the family of substitution ciphers. 

With this cipher each character is represented by another character in the alphabet, 

more specifically the whole alphabet is shifted by a set amount to encrypt the data.  

 

Fig 4: Caesar Cipher with a shift of 3 

[03/04/07 http://upload.wikimedia.org/wikipedia/commons/2/2b/Caesar3.svg] 

The set amount that the alphabet is shifted by becomes the key, anyone  with 

knowledge of this key should be able to reveal the true contents of the ciphertext and 



Cryptographic Techniques for Network Security 

 

-25- 

conversely anyone without knowledge of the key should not be able to interpret the 

ciphertext as the original plaintext. This can be illustrated clearly with the a id of an 

example: 

  

Plaintext: 

“It is better to remain silent and be thought a fool than to speak out and remove all 

doubt” 

Ciphertext: 

“Ny nx gjyyjw yt wjrfns xnqjsy fsi gj ymtzlmy f kttq ymfs yt xujfp tzy fsi wjrtaj 

fqq itzgy” 

The above ciphertext initially appears to be nonsense, however once you know the 

key is “E” the text becomes legible.  

 

Back when Julius Caesar first used this technique there were considerably less 

people with the ability to read and write, additionally the field of cryptography was a 

relatively new technology in its infancy. Consequently there are several weaknesses 

with this cipher. In addition to those started above for the substitution cipher there is 

the added flaw that only 26 possible keys for encryption (there are only 25 feasible 

keys as the 26
th

 would be a full rotation) can exist. A cryptanalyst, who intercepted 

the ciphertext, could run through each of the 26 keys until he found one that was 

legible in a relatively short time. Should the language not be English the num ber of 

keys would correspond to the length of the alphabet concerned. Whichever language 

is used, the number of possible keys is very likely less that the relatively large 

number of feasible keys available for other ciphers.  

 

Due to the weaknesses present in the Caesar cipher there is an adaptation called the 

Modified Caesar cipher. With this method a key contains a number of shift values. 

For example, if a key has a length of 7 shift values, the key could be 

{3,20,11,6,3,14,8}. Therefore the first letter of the message will be shifted by 3, the 

second by 20, and so on. Once the key is completed it repeats itself until the entire 

message has been enciphered or deciphered. This has the same effect as the Vigenère 

cipher discussed below. 
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Atbash 

This cipher simply represents letters of the ciphertext alphabet in reverse order: 

Plaintext:  abcdefghijklmnopqrstuvwxyz 

Ciphertext:  ZYXWVUTSRQPONMLKJIHGFEDCBA 

 

Vigenère cipher 

The Vigenère cipher bares much resemblance to the Modified Caesar cipher, 

discussed above, but using a key phrase instead of the numbers in the shift vector . 

The encryption process for this cipher takes each individual letter of a plaintext 

message and combines it with a letter from the key, together these two letters act as 

coordinates for a position on the Vigenère square shown below: 

 

Fig 6: The Vigenère square 

[23/04/07 http://upload.wikimedia.org/wikipedia/commons/c/c7/Vigenere -square.png] 

Once each character of the key has been used, the key repeats itself. So say the 

plaintext is SQUARE and the key FROG, the key used would become FROGFR 

 

Plaintext:  SQUARE 

Key:   FROGFR 

Ciphertext:  XHIGWV 
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The below image demonstrates how the first character of the plaintext message, S, is 

combined with the first letter of the key, F, to find the ciphertext letter X. 

 

Fig 7: Encrypting the first letter of the message with the Vigenère cipher 

To decipher a message, reverse the process, starting by finding the character of the 

key, and then find the ciphertext letter along the same row and then find what 

column it is on to reveal the plaintext. 

 

This cipher is a lot more effective than the Caesar cipher  if the chosen password is 

long enough. A single character could be represented as any other character, there is 

no “direct” correlation making it more difficult to crack. For cryptanalysis see 

autocorrelation and lab 3 below. There are very strong similarities with this cipher 

and the Excusive-OR cipher (Vernam cipher) described later. 

Playfair cipher 

Developed by Charles Wheatstone, the Playfair cipher makes use of digrams and 

comprises of several small steps. First a phrase is needed to make the Playfair 

square, this is the equivalent of a key. For an example the following phrase shall be 

used: 
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“Treat your password like your toothbrush.  Don't let anybody else use it, and get a 

new one every six months.” 

- Quote by Clifford Stoll [Stoll95] 

 

Next, working from left to right, replace the J‟s with I‟s, then remove all spaces and 

any repeated letters. Any letters not included in the phrase should be included  at the 

end (with the exception of J): 

 

“TREAYOUPSWDLIKHBNGVXMCFQZ” 

 

The  J‟s were replaced with I‟s so the phrase would fit into a Playfair square, which 

is five by five in size. This is the next step:  

 

T R E A Y 

O U P S W 

D L I K H 

B N G V X 

M C F Q Z 

Fig 8: A Playfair Square 

 

Next the plaintext intended for encryption needs to be broken up into digrams. These 

do not include spaces. A null (e.g. the letter „X‟) is inserted for any duplicate letters 

and if the total number of letters is odd (so the last letter fits in a digram). Again any 

J‟s are replaced with I‟s: 

 

“Information is not knowledge” 

-Albert Einstein 

“IN  FO  RM  AT  IO  NI  SN  OT KN  OW  LE  DG  EX” 
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For each digram find their places on the Playfair square. Dependant on the two 

letters position with respect to each other, the rule to derive the ciphertext 

representation can be chosen. The three rules are:  

 

Rule 1: If the two letters lie in the same row of the key then each letter is replaced 

by the one on its right in the key matrix. 

* * * * * 

* A C B D 

* * * * * 

* * * * * 

* * * * * 

AB => CD 

 

 

Rule 2: If the two letters lie in the same column of the key then each letter is 

replaced by the one below it in the key matrix. 

* A * * * 

* C * * * 

* * * * * 

* B * * * 

* D * * * 

AB => CD 

 

Rule 3: If the two letters are not in the same row or column then the first letter is 

replaced by the letter that is in the row of the first letter and the column of the 

second letter. The second letter is represented by the fourth corner of the rectangle 

formed by the three letters used so far.  

* * * * * 

* A * * C 

* * * * * 

* * * * * 

* D * * B 

AB => CD 
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Remark 1: In case of rule 1 and 2 if one character is at the right end of the row or the 

lower end of the column, so the row or column is considered to be enlarged wrap-

around. 

Remark 2: You also can enlarge the alphabet with digits or symbols, but the number 

of characters always has to be a square (5*5, 6*6, …).  

 

The final stage of enciphering the message is shown below 

IN  FO  RM  AT  IO  NI  SN  OT  KN  OW  LE  DG  EX 

Becomes: 

LG  MP  TC  YR  DP  GL  UV  DO  LV  UO  IR  IB  YG 

 “Information is not knowledge” = lgmptcyrdpgluvdolvuoiribyg 

 

To decipher the ciphertext the reverse to the rules are applied, so should the two 

letters be in the same row (rule 1) the letter to the left of each letter will be the 

plaintext character. 

 

Transposition techniques 

The above examples are examples of substitution ciphers, which represent a 

character with another character, or a set of characters with another set of characters. 

The other main method is the transposition technique. This family of ciphers encrypt 

data by altering the order of the bits or characters of the plaintext, this can be show 

with a simple example: 

Plaintext:  HELLO 

Ciphertext:  LOELH 

 

Consequently any ciphers that belong to this family must also belong to the family 

of block ciphers, substitution ciphers however may belong to either the family of 

block cipher or stream ciphers. 
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Rail fence cipher 

The rail fence cipher is a relatively simple cipher and belongs  to the family of 

transposition ciphers. It is seldom used unaccompanied by other ciphers due to its 

simplicity but can still be found present as part of other more complex ciphers used 

today. 

 

The concept of this cipher is there is a fence on which characters are written 

vertically along rails as apposed to the conventional writing horizontally. Once the 

given plaintext has been written out, extra characters are added to the end , so as the 

block size is a standard length, these extra characters are referred to as nulls and also 

serve the purpose of adding extra confusion to a cryptanalyst. The example below 

displays the arrangement of “Rail fence cipher” using this technique:  

 

 

Fig 10: Rail fence cipher with a standard block size of 7 

 

After a message has been arranged appropriately, the characters are re-read 

horizontally and are then encoded as ciphertext. The above example becomes:  

 

“RLNCHQEAFCIEZBIEEPRJH” 

 

The key is the length of the rails and in this case is 3. 

 

Cascading cipher 

A cascading cipher is a cipher that incorporates several techniques collectively. 

Trying to break a simple message that has been encrypted with say the Caesar cipher 

is relatively simple however should that message have been encrypted with the 

Caesar cipher, then the Playfair cipher and then the Rail fence cipher it would be 

harder to decipher. 
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Vernam cipher  

The Vernam cipher, sometimes referred to as simply Exclusive-OR (or X-OR) is 

arguably one of the most simple and effective techniques available for encryption. 

Working at the binary level this technique takes two bit streams, one of which a 

binary representation of a plaintext message and the other of the key, and inputs 

them both to an Exclusive-OR logic gate. This gate gives a unique output: 

 

Input 1  

(plaintext binary) 

Input 2 

(key binary) 

Output 

 

1 1 0 

1 0 1 

0 1 1 

0 0 0 

 

With only the output it is thought almost impossible to derive the original plaintext 

without the key, however, patters can arise as the key is repeated or not truly 

random. This is further discussed later under the description of the one-time-pad. 
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1.7 Modern Ciphers 

This section will look at how cryptography fits into present day network security as 

well as some of the more advance techniques used and how they have evolved from 

and improved upon older legacy ciphers. 

DES 

The Data Encryption Standard (DES) was first implemented in the USA during the 

1970s. Although it has since been superseded by Triple DES and more recently AES, 

it has been included as a modern cipher as it is still largely used throughout the 

world. 

 

 

“DES did more to galvanize the field of cryptanalysis than anything else. Now there 

was an algorithm to study.” 

- Bruce Schneier 

 

With this cipher a message is first broken down into 64 bit size blocks, and then 

each 64 bit block is further divided into two 32 bit blocks that are processed together 

to obtain the results. These two 32 bit blocks are first entered into the function IP 

(this has little cryptographic relevance) and then the two are alternately combined 

with the key and enciphered together using the Feistel cipher. This is repeated 16 

times, until the two halves are entered to the FP process (the inverse of the IP 

process) where they complete their transition from plaintext to ciphertext.  

 

The Feistel cipher takes the two halves, combines one half with the key in the F 

function (see figure 11) and then runs the two through an X-OR gate ( ), the X-OR 

gate is described in more detail under the earlier section of the Vernam Cipher. The 

output of this process becomes the new value for the half not combined with the key. 

Then the process is repeated but the halves swap their roles, this is shown with a 

diagram below: 



Cryptographic Techniques for Network Security 

 

-34- 

 

Fig 11: The Feistel Cipher 

[25/04/2007 http://upload.wikimedia.org/wikipedia/en/d/d2/Feistel.png] 

 

The decryption was designed to be extremely similar to the process of encryption, 

the only difference is the subkeys are applied in the reverse order.  

 

One weakness of this cipher is the fact that the key is only 56 bits long (it is in 

actual fact 64 bits long, however 8 of those bits are not used and are wrongly called 

parity bits). This is, in comparison to other modern ciphers, a very small key length, 

and as such is susceptible to attacks such as brute force. It has been claimed that the 

encryption can be broken in less than 24 hours using this attack method (This claim 

comes from using the software Deep Crack and distributed.net in conjunction). This 

issue has since been addressed with the development of Triple  DES, and more 

recently Advanced Encryption Standard (AES) which allows for keys up to 256 bits 

in length. 

 

Triple DES 

Taking into account that the DES key is considered too short Triple DES was 

developed and works with either two or three DES keys collectively. As DES is 

already a well established method TDES was made so as it could make use of the 
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existing hardware/ software used of its predecessor. The methodology of this cipher 

is that a message is encrypted with one key, then decrypted with a second, and 

finally re-encrypted with either the first key or a third key dependant on the system 

used. This method thus increases the key length from 56 bits to either 112 bits or 

168 bits dependant on how many keys are used. 

 

Diffie-Hellman  

Developed by Whitfield Diffie and Martin Hellman in 1976, Diffie-Hellman was the 

first algorithm to incorporate an asymmetric key system (It has since been 

established that there was a British implementation of such a system developed in 

1973 by the government organisation GCHQ, this was not publicly released until 

2003 due to security reasons). 

 

The concept behind this protocol is based on the belief that it is incredibly difficult 

to calculate large discrete logarithms. The mathematical representation of the 

protocol is demonstrated below with the aid of a simple example: 

 

There are two users wishing to communicate, Bob and Alice. Before they 

communicate securely they must decide on a secret key to use, s. Eve is secretly 

listening to their transmissions. This protocol has been designed to allow both 

intended parties, Bob and Alice, to know s but not to allow any one intercepting the 

transmission. 

 

Key 1 or 3 

Key2 

Key1 

e
n
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DES 
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DES Plaintext Ciphertext 
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 First Bob sends Alice a value for g and p. These may sent over an unsecured 

line and so we will assume that Eve has intercepted them.  

For our example we shall use the numbers 

g = 5 

p = 23 

 Bob selects a large random positive integer, a, this is his private key. He 

combines his key with the previously stated values g and p using the 

following formula: 

X = g
a
 mod p 

Bob‟s private key is 5 

X = 5
6
 mod 23 = 8 

X is then sent to Alice. 
 

At the same time, Alice combines her secrete key, b, in the same process. In 

this case b = 15  

Y = g
b
 mod p 

Y = 5
15

 mod 23 = 19 

Y is sent to Bob. 
 

Eve, who intercepts both messages, knows only that  

5
a
 mod 23 = 8 and 

5
b
 mod 23 = 19 

But she does not know a or b. 

Although it may be possible to derive a and b given this information, it would 

be extremely hard and take a great amount of computation power  with large 

numbers, thus this is the strength of the Diffie-Hellman key exchange. 

 Now that Bob has Y, he can use the last formula to find s 

s = Y
a
 mod p 

s = 19
6
 mod 23 

s = 2 
 

Conversely, Alice can apply the same principle to derive s: 

s = X
b
 mod p 
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s = 8
15

 mod 23 

s = 2 

 

The nature of this technique means that at no point either party need transmit t heir 

private key without encryption, thus protecting them from any one intercepting the 

communication. A representation of this is the brief case example. Bob wants to 

send Alice a secrete gift, but doesn‟t want anyone to know what it is, so he locks it 

in a brief case and sends it to her. The problem is that Bob can‟t send Alice his key 

because it may be intercepted and used to unlock the brief case, Bob must  also keep 

his key private. Any one intercepting the briefcase is unable to open it. When Alice 

receives the brief case, she locks it with her private key and sends it back to Bob, 

again any one intercepting would have no idea as to what key was needed to unlock 

the brief case. When Bob receives the brief case he removes his lock and sends it 

back to Alice, who in turn may remove the final lock to reveal the cases contents. 

 

Fig 12: The brief case example 

 

As a final note, both numbers g and p must be selected wisely to ensure security. 
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RSA 

RSA was released in 1977 by Ron Rivest, Adi Shamir and Len Adleman (the name 

RSA coming from the surname of each developer). Its design was based on that of 

the Diffie-Hellman concept and has since become the most widely used public key 

system to date. 

 

The cipher comprises of two keys, a public key and a private one. As the names 

suggest the public key can be known by any one, whereas the private key is to 

remain secret. When a message is sent from the client, it encrypts it using the servers 

public key, once encrypted this message may only be decrypted with the private key. 

The mathematical concept behind the cipher can be broken down into a series of 

steps which are explained below: 

 

1. Choose two large prime numbers, p and q. To aid in understanding of this 

cipher, an example is included (For mathematical simplicity,  small prime 

numbers for p and q are used in the example, in practice for efficient security 

these numbers should be large enough to generate a product in excess of 300 

decimal digits long) 

p as 17 

q as 11 

2. Calculate n by multiplying p by q: 

n = pq = 17 * 11 = 187 

n represents the modulus to be used for both the public and private key 

operations and consequently determines the maximum size of the message‟s 

block size. 

3. Calculate the totient for n,  (Like the other mathematical concepts 

mentioned in this section, a full explanation of the totient can be found in the 

earlier chapter of Mathematical Principles). An expression for this is: 

 

 = (17-1)*(11-1) = 160 

4. The integer, e, is to be chosen so as: 1 < e <  

e should also be coprime to , so e and  should share no factors other 
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than 1 (and -1). For our example we will use the value 7 

e=7 

e represents the public key exponent and may be released to the recipient of a  

transmission. 

5. Next, the private key component, d, should be calculated. This number is 

selected so as it fits the following formula:  

 

where k is a positive integer. That is to say the public key, e, and private key, 

d, have a congruence relationship 

 

Additionally, the value for d must be less than  . There should only be 

one value that satisfies the above equation, and in the case of our example 

that is 23. 

de = 23 * 7 = 161 

161 mod 160 = 1 

Therefore:  

d = 23 

6. e is then combined with n to make the  public key {7, 187} and d with n to 

make the private key {23, 187}. 

7. To encrypt the plaintext, PT, as ciphertext, CT, use the following formula: 

CT=PT
e
 mod n 

This ciphertext may be transmitted to the recipient.  

In the context of our example we take the plaintext value 88: 

PT = 88 

CT=88
7
 mod 187 = 11 

8. To decipher the ciphertext, apply the following formula: 

PT = CT
d
 mod n 

PT = 11
23

 mod 187 = 88 

 

Factorising n 

The number n, shown above, is the product of two large prime numbers, p and q, 

consequently it is possible to derive both p and q from the value n, as there will only 
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be one pair of prime numbers that multiply to give n, accordingly n is known as a 

semiprime (also called biprime). This may be considered an obvious security risk, 

however, factorising the value of n, should n be sufficiently large, would take a 

tremendous degree of computing power. To illustrate this there is an ongoing RSA 

challenge, where the RSA laboratories have offered sums of money to any one able 

to find the two prime numbers that multiply to give their published semiprime n. 

After 16 years of running the challenge, in May 2005, the largest semiprime to be 

broken has been the RSA-200, a 200 long digit, that took a cluster of 80 2.2 Ghz 

computers continually running for 3 months to calculate. This is estimated to be the 

equivalent of a single 2.2 Ghz machine running for 55 continual years. (source 

http://www.rsa.com/rsalabs/node.asp?id=2879). As it suggested n should be no less 

than 300 digits, RSA can still be considered secure.  

 

Timing attacks 

Another vulnerability with this cipher, that has recently been exposed,  is its 

weakness against a timing attack. Here a cryptanalyst times how long decipherment 

takes, based on the time taken they can make an assumption as to whether the text 

was acceptable or not. At the binary level, a 1 bit will take longer than a 0 bit as  

there is a more complex calculation taking place. Despite the implications of this 

attack, it is relatively easy to prevent against, below are the three methods to negate 

its effect: 

 Constant exponent time, each calculation takes the same time period to 

complete. Although effective this method can reduce the efficiency of a 

system as all calculations must take the longest calculation time to complete.  

 Random delay, to combat the negative performance issues with the constant 

exponent time method, delay times are added at random. 

 Blinding, considered the most effective of these method, this technique 

multiplies the entire ciphertext message by a random number prior to 

performing calculations. 
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Hash functions 

A hash function is one that takes plaintext data and from it derives a fixed length 

hash value. The process is one way, so with only the hash file the original data can 

not be retrieved. The primary purpose of hash functions is to encrypt passwords 

allowing them to be stored in a publicly accessible location; this is especially true of 

Unix systems. Because the process is one way, password hashes must be compared 

to one another for authentication. This is apposed to the conventional approach of 

encrypting and decrypting sensitive data such as a password.  

 

If the hash value‟s length is too short  there is a weakness with the concept. Because 

hashes are of a fixed length, there is a set number of possibilities they may take. Say 

there are only 4 possibilities, after 5 encryptions there would be at least one instance 

where two hashes for different input data have the same hash value, this is known as 

a collision. 
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1.8 “Unbreakable” Ciphers 

This chapter discusses the theories behind the methods of securing data that are 

believed to be unbreakable, their practicality and whether they truly are unbreakable.  

 

One-Time-Pad 

A one-time-pad is a technique believed to be unbreakable, although it does have 

several practicality issues. The idea with this technique is that the key should be the 

same length as the message it is being used to encipher, and, should contain no 

intentional patterns and should be random. Working at the binary level, the key is 

used to encrypt the plaintext message by inputting the two streams of data to an 

exclusive-OR logic gate. Further details of this gate can be found under the simple 

ciphers chapter. 

 

Input 1  

(plaintext binary) 

Input 2 

(key binary) 

Output 

 

1 1 0 

1 0 1 

0 1 1 

0 0 0 

 

With possession of only the ciphertext data, a cryptanalyst would be unable to 

disassemble either the key or plaintext. The reason for the X-ORs efficiency is that 

regardless of the ciphertext bit been 1 or 0, the probability of either of the inputs 

been 1 or 0 are equal. That is to say, if you were to intercept the ciphertext binary 

representation: 

01001101 

All that you would know is that for any 0‟s both the plaintext and key had the same 

value and for any ones they had alternative values. As the key should be random 

there will be no way in which to derive the plaintext with out knowledge of the key.  

 

With this being such a simple and effective technique it would seem an obvious 

cipher to use for mainstream cryptography, however, the cipher is not considered 



Cryptographic Techniques for Network Security 

 

-43- 

practical enough. The primary reason for these reservations is the length of the key. 

Having a small simple key like say the word “Frog” is relatively easy to remember, 

having a potentially indefinitely long key, which is random in content, is not 

realistically feasible for a human to remember. As a result of this, the key would 

have to be stored electronically, and for remote authentication would require the 

transmission of such a key in addition to the message. Regardless of the additional 

network strain (double!) this would be an illogical solution as should the ciphertext 

be intercepted, then by the similar means so could the key, thus the plaintext would 

be revealed. The only feasible method for using this technique would be to have 

some form of hardware that contained the relevant information such as a DVD or 

flash drive, this could contain the key and only authorised personnel granted one, 

however this can not be as secure as a key that has been stored mentally.  

 

As a result this method is seldom used although could have a potential future, 

particularly with the video industry where DRM (Digital Rights Management) is an 

increasing issue. One-time-pads have been a suggested method to prevent privacy 

where by a unique key would be sold as hardware, this would only work with its 

associated ciphertext media and so the two would be needed in conjunction with 

each other. There is one obvious flaw with this idea though, should someone with 

intent to copy a movie have possession of a coordinating key and ciphertext device, 

they could obtain the plaintext and thus copy it freely. 

 

The DES cipher attempts to address the key length problem by using a short key that 

is used to encrypt data several times and so acts like a longer key. Having a short 

key however leaves the cipher susceptible to attacks such as brute force.  

 

In conclusion, there are no known ciphers that are perfect, none that are thought 

unbreakable and yet at the same time practical. That does not however, mean there 

never will be. Cryptography is a technology that has progressed immensely in recent 

years, but has by no means finished its development.
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1.9 Possible Future Ciphers and Security Techniques 

Moore‟s law states that every 18 months the power of computers will double. The 

faster computers become, the more keys they will be able to encrypt and compare in 

a given time (using the brute force method described in the chapter 1.3 

Cryptanalysis). As computers become better able to break ciphers, so too must the 

ciphers become better able to withstand attack. One solution , that has already been 

implemented to maintain the level of security, has been to use longer keys, this has 

been seen with DES moving to Triple DES and AES (a key length of 56 bits to up -to 

256 bits). When computers get powerful enough to break these longer keys , even 

longer ones will have to be deployed to sustain the level of security, eventually the 

password could become so long it is impractical as is the case for the one-time-pad. 

Although in keeping with Moore‟s law it will take many decades for the speed of 

computing to call for passwords to become so long that they become impractical , 

that day will one day come. 

 

There are however some technologies that could cause the speed of breaking a 

password to become even faster than anticipated by Moore‟s law. One of which is 

the theory of quantum computing. Should this theory ever prove successful (and if it 

does it is predicted to take a few decades to become practical), a vast leap in the 

speed of computing could be seen, one much greater than Moore‟s prediction. 

Additionally there is an increasingly trend to cluster computers. This method 

distributes a task across several computers in a cluster (or a cell) the concept is that 

computer working together can accomplish a set task much more efficiently than one 

by itself, and is a principle used by almost all super computers, for further 

information on this topic refer to the Blue Brain Project by IBM 

(http://bluebrain.epfl.ch, 2005). As network speeds become even faster, cluster 

algorithms even smarter and hardware even cheaper, speeds are set to increase 

further, so too is the time to break a password. 

 

In conclusion, the speed and power of systems will inevitably increase, and likely 

put an added strain on the present cryptographic techniques. As Bruce Schneier once 

said, we must protect ourselves with mathematics. So, like we have found logarithms 

to be a mathematical challenge ideal for cryptography (Diffie -Hellman) and have 

http://bluebrain.epfl.ch/
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then progressed to the challenge of prime numbers (RSA), we must find further 

mathematical challenges to secure our data. One challenge that is likely to be an 

important concept is to understand the complexity of elliptic curves and lattices. As 

our understanding of the universe becomes ever more diverse and complex we will 

inevitably come across mathematical conundrums yet more challenging and these 

will surely become the basis of the coming generations of ciphers. 
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LAB SESSIONS 

2.0 The CrypTool 

Development of the CrypTool began in 1998 by various German Universities and 

companies, since then, it has become an open source project and has involved 

developers all over the world. Its purpose is to aid users with understanding the 

various concepts and techniques used in cryptography. The program covers a range 

of modern ciphers such as RSA, DES and AES as well as classically used cipher s 

including the Caesar, Playfair and Vigenère ciphers. CrypTool provides the user 

with a variety of tools designed to aid with analysis of messages. Such tools include 

Entropy, Floating Frequency, Histogram, N-Gram, Autocorrelation and Periodicity.  

 

At the time of writing this update of the project, the current version of CrypTool is 

1.4.10 and it is available on the Windows platform. (It is also worth noting that 

CrypTool works perfectly well on many distributions of Linux when used with 

Wine, a Windows emulator). For 2008 there are plans to have a platform 

independent version build with Java; and a beta of the successor build in C#.  

Areas of use 

The CrypTool, boasting 3000 unique downloads a month, has arguably become the 

de facto tool for studying cryptography. It has two primary target markets: 

Industry 

Although it is not known exactly who uses the CrypTool (besides the download 

records and the explicit feedback given) it is thought members of the technology 

industry would be prime users. Fields where a user is extremely likely to use the 

software include military, government, banking, telecommunications and software 

development. 

Universities 

Primarily students and lectures of computing type courses are likely to use the 

software. 
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2.1 CrypTool Manual 

This next section will be a selective breakdown of the tools and functions within the 

CrypTool and will give an explanation as to how to use each. This should be used as 

a reference when undergoing the lab sessions. For simplicity this section will look at 

each of the menu headings in turn. It is worth noting at this point that the CrypTool 

contains an extensive online help file which is very informative. Should you feel 

unsure at any point as to how to use a particular aspect of the application, press F1 

and the relevant help page should be located. 

 

 

File, Edit, View 

Like the majority of Windows applications the menu buttons File, Edit and View 

have standard functionality allowing the user to save files, open them, edit them and 

alter the view of the program etc. 

Crypt/Decrypt 

This menu button encompasses the cipher algorithms available with the CrypTool. 

They are broken down into four sections; Classic Symmetric, Modern Symmetric, 

Asymmetric and Hybrid. With a text file open, the user is able to encrypt or de crypt 

the data from this section. A description of how exactly to implement these ciphers 

can be found later on in the formal lab sessions, additionally there is an 

accompanying description of the mathematics behind each of the significant ciphers 

available earlier in this document. 

 

In order to use ciphers from the asymmetric or hybrid headings it is required that 

there is first an asymmetric key pair produced or that you use one of the pre-

generated key pairs. These can be generated and managed using tools found under 

the next menu button, Digital Signatures/PKI. 
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Digital Signatures/PKI 

This selection of tools is designed specifically for supporting a user implement ing 

various aspects of public key encryption. More specifically PKI (standing for public 

key infrastructure) combines a public key with a user identity and so is more 

applicable to authentication. So for example, there is a tool in this section that 

generates a key pair for RSA, this tool incorporates aspects of inputted user details 

so as the generated keys are affiliated with the user, and so is more appropriate for 

authentication. 

 

Under this heading the two most useful options are:  

 

Digital Signatures/PKI > PKI > Generate/Import Keys –  A tool for creating new 

asymmetric key pairs. 

Digital Signatures/PKI > PKI > Display/Export Keys –  This tool is for 

managing available 

keys. 

 

There is a tutorial for each under lab session 2.  

Indiv. Procedures 

The menu button Indiv. Procedures comprises of individually submitted tools to the 

CrypTool. They are often not directly related to the other functions available but 

comprise of a wide arsenal of tool that demonstrate various ciphers and concepts. 

The specific topics covered are: 

 Hash calculators – comprising of many algorithms 

 RSA tools – tools for each stage of the RSA encryption process 

 Network demonstrations – visual aids for intercepting a message or public 

key exchange 

 Mathematical tools – often portrayed in an interesting manner, one example is 

the mod calculator that compares itself to planets around the solar system 

 Animations – specifically the ANIMAL animator, and now with the newest 

version of CrypTool there is the inclusion of the AES Animator and one for 

the Enigma‟s algorithm. 
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 Games – a method of teaching in a fun manner the number shark educates 

students about prime numbers 

 Other – there are several other tools under this section, most of which useful 

applications that do not easily fit under one of the other headings . 

 

Analysis 

Included under this heading are tools for analysing the strength of the encryption 

algorithms, of hashes and of random data.  

 

The generic tools include: 

Entropy 

Entropy is a tool within CrypTool that calculates the occurrence of each character 

relative to each of the others. A simple way of thinking of it is a calculat ion of how 

level the relative frequency graph would be, this is not entirely accurate but is a 

simplified comparison, for a more accurate description of the mathematics behind 

this feature see the CrypTool‟s help section titled “Calculating the entropy of a 

document”. 

 

The maximum possible value that can be calculated when using a standard English 

alphabet is 4.70 and the lowest is 0. Generally speaking, a high calculated value is 

considered less likely to be deciphered by a cryptanalyst, conversely a low value 

tends to correspond with weak security. This is particularly true of the substitution 

cipher, as statistical analysis is its main weakness. 

 

Floating Frequency 

This tool breaks the message down into blocks of 64 characters and then displays the 

range of different letters for the block surrounding each letter. These results are then 

displayed to the user in the form of a line graph with the aim of allowing them to see 

what parts of a message have high levels of variance and which have comparatively 

low variance. The purpose of this excursive is often to derive the nature of the data 

that has been encrypted. Typically images and text files tend to have a relatively low 
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variance between 5 and 20 for images and 18 and 30 for text, where as computer 

binary files, such as executable programs, tend to have a much higher lever of 30 to 

40, and compressed or encrypted files tend to take advantage of the various possible 

characters and can have a variance of anything up to the maximum value of 64 

(though generally have just under this value). 

Histogram 

Using this tool shows you the relative frequency of each of the characters in the 

document. It is very useful for comparing the prevalence of different letters and can 

help derive the nature of the information and in come cases even reveal some of the 

character‟s representation. This applies especially to monoalphabetic substitution 

ciphers like the Caesar cipher, where statistical analysis is its main weakness, so you 

could assume a character with the largest frequency is the letter E. 

 

N-Gram 

The N-gram breaks up a given message into blocks of size N, ignoring all spaces. 

Once all the available blocks have been established they are displayed in order 

starting with the one with the most occurrences. 
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Selecting the histogram option here sets the block size to 1, 

digram sets it to 2, trigram 3 and the N-gram allows the user 

to choose how long he wants the block size to be. 

 

The last option here allows the user to specify how many 

results to display. 

 

Autocorrelation 

The autocorrelation tool analyses different sections of a message and compares them 

to find similarities. It is often possible to derive the length of the key using this tool , 

especially when analysing the messages encrypted with the Vigenère cipher, the 

Byte Addition or Exclusive-OR. 

 

Periodicity 

This tool searches for repeated fixed patterns in a document that start from any point 

and continue on through to the end of the document. The pattern has two notable 

features, its offset and period. The offset is the start position of the cycle, counting 

from the first character of the document, and the period is the length of the set o f 

characters that are repeated. 

 

Examples: 

aaabbbbb  – cycle of b, offset of 4, period of 1 

aaabcdbcd  – cycle of bcd, offset of 4, period of 3 

aaaaadcab  – Is not a valid period 

 

Other Tools 

In addition to the core tools available under the Analysis heading, the CrypTool also 

offers a variety of extra features designed specifically for analysing individual 

ciphers. Under this menu is a whole range of tools designed to illustrate the 
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weaknesses present in each cipher, an example is the lattice-based attack available 

for the RSA cipher. 

 

Options 

Allows the user to alter specific attributes for the various components of the 

CrypTool, one example that is explored further in the lab sessions is the text options 

dialog that allows the user to specify what attributes of a text are encrypted and how 

grammar is treated. 

 

 

 

Window 

Provides window management. 

 

Help 

Included with the CrypTool is an extremely comprehensive technical online manual. 

The help tab provides easy navigation through this manual as well as a separate link 

to a detailed explanation for each of the included scenarios and tutorials. 
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Additionally there is a reference to a readme file, describing the open source project 

itself, and a reference to the script  with around 200 pages introducing the 

mathematical background of parts of CrypTool. In the start menu of the Windows 

task bar you can find within the CrypTool menu the presentation, describing the 

program CrypTool and motivating the use and understanding of cryptography.  

 

Other 

Throughout the CrypTool visualizations there are certain common symbols that 

regularly reoccur: 

 

 

Symbol for preliminary steps (e.g. choosing a file) 

 

Symbol for process data (e.g. the session key)  

 

Symbol for stored data (e.g. the asymmetric key)  

 

Symbol for a named standard procedure (e.g. encrypt text 

symmetrically) 

 

Lab session note 

Prior to beginning the formal lab sessions it is integral  that students have fully read 

and comprehended the relevant sections of this document (each lab will have 

suggested prerequisite reading outlined in its information box). The intention of the 

lab session is to show the student the studied ciphers in action and to teach them 

how to fully utilize the CrypTool. 
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2.2 Lab 1: Introduction to Cryptography and CrypTool 

Estimated time for completion 1 hour 

Available marks   10 

Specific Required reading  CrypTool Manual,  

     This Report: 

     1.2 What is Cryptography 

     1.3 Cryptanalysis 

     1.6 Simple Ciphers 

 

Introduction 

The CrypTool is a powerful application used to aid a user with the encryption and 

decryption of data. The aim of this lab is to introduce you to the CrypTool by 

familiarising you with its basic functions. 

 

Installation 

To install CrypTool on any Windows type Operating System, simply download the 

version 1.4.10 from the website http://www.cryptool.org/ and double click on the 

executable SetupCrypTool_1_4_10_en.exe then follow the onscreen instructions. 

After installation the file all you will need to use is CrypTool.exe. 

 

The Caesar cipher 

One of the more simple ciphers you can implement using the CrypTool is the Caesar 

cipher, this is a form of the substitution cipher and is explained in great er detail in 

the Report. 

 

To begin with, open the CrypTool and go File > New. In the newly opened window 

type the message you wish to encode. The contents of your message is your personal 

choice, however, you should ensure its length is greater than 64 characters for the 

purpose of later analysis, in general the greater the length of your message the more 
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accurate the later analysis will be. Alternatively, select the example text 

accompanying the CrypTool by clicking File > Open… and then selecting 

examples\Startingexample-en.txt.  

 

Next select Crypt/Decrypt > Symmetric (classic) > Caesar / ROT-13… From here 

you will be presented with the option of encrypting with either Caesar or ROT-13 

variants. 

 

 

The key that you input here is the amount that the alphabet will be shifted by. You 

can enter the key as a letter of the alphabet or as a number. The letter will 

correspond to the shift of the alphabet, so for example A will shift the alphabet by 1 

or 0, as it is the first letter in the alphabet, B by 2 or 1 as it is the second etc. 

ROT-13 is an abbreviation for Rotate by 13 places, and so would have a key of M (if 

the 1
st

 alphabet character is assigned the value 1). Additionally, the shifted alphabet 

is demonstrated below to clearly illustrate what the cipher wil l do.  
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Once you have selected your key select Encrypt. A new window will open with your 

encrypted message. Now you can analyse the strength of the encryption using a 

variety of techniques. We shall begin by looking at the entropy, for a description of 

what entropy calculates please refer to chapter 2.1 CrypTool Manual. Select from the 

menu bar Analysis > Tools for Analysis > Entropy. This should display the 

calculated result. In the same manner proceed to analyse your text using the other 

tools available: 

 Floating Frequency 

 Histogram 

 N-Gram 

 Autocorrelation 

 Periodicity 

All of which can be accessed through the menu bar, Analysis > Tools for Analysis. 

Again refer to chapter 2.1 CrypTool Manual for an explanation of each tools 

findings. Please note that for some of these tools it is necessary for the messages 

size to be greater than 64 characters.  

 

Q1. Which tool or technique would be most effective for a cryptanalyst to use to 

decipher a text encrypted with the Caesar cipher, and why? 

[3 marks] 

[Model answers see chapter 3.2]. 

 

You will notice that any punctuation is left unchanged, as too are any numbers. To 

change this Options > Text Options and from here you can select what attributes of 

a message the cipher will alter and which it will leave unchanged. Exper iment 

encrypting the same message with the Caesar cipher with different settings selected 

from the text options. Decipher each message after doing so and see if the 

deciphered message still has the same punctuation, spacing etc.  
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The Vigenère cipher 

The second cipher to be looked at is the Vigenère cipher. Like with the Caesar 

cipher open a new document and put in your message, make sure to use the same 

message as earlier for later comparison. To encipher your message select 

Crypt/Decrypt > Symmetric (classic) > Vigenère. Think of a key to use and select 

Encrypt. Like earlier, analyse your encrypted message with all of the tools 

available. 

 

Q2. What do you notice about the histogram results when text is encrypted with the 

Vigenère cipher in comparison to the results of the Caesar cipher? Why is this the 

case? 

[3 marks] 

 

To decipher, once again select Crypt/Decrypt > Symmetric (classic) > Vigenère, 

type the key and then Decrypt. 

 

Try experimenting with different length keys and see how that affects the ciphertext. 
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ANIMAL 

Animal is a tool within the CrypTool that displays the concepts behind a cipher in a 

user friendly fashion, by the means of an animation. The animation of a cipher takes 

example data and then runs through each of the processes that the cipher requires. 

This tool is extremely beneficial as it reinforces a users understanding of a given 

cipher by showing each process of a given cipher with a high degree of detail. We 

will use it now to see data been encrypted with both the Caesar cipher and the  

Vigenère cipher. 

 

To use it select from the menu bar: Indiv. Procedures > Visualization of 

Algorithms > Caesar... The machine may take a minute for Animal to load. When it 

does, select the play button from the bottom menu bar to begin the animation . 

 

 

 

Animal also allows for the altering of speed and magnification, both menus are 

situated in the top menu bar. 

 

After watching the Caesar cipher encryption, repeat the process for the Vigen ère 

cipher. 

 

Playfair 

The next cipher that we will look at is the Playfair cipher. Using this cipher we shall 

encrypt one of Albert Einstein‟s famous quotes: 

 

The difference between stupidity and genius is that genius 

has its limits. 

 

Select this cipher for encryption in the usual manner. Make sure the 5x5 Matrix is 

selected (the 6x6 Matrix is for the inclusion of numbers) and use the key phrase: 

 

AlbertEinstein 
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You should instantly see the key phrase represented in the Playfair square (if you are 

using 1.4.00 or earlier the Playfair square may not display the data accuratel y, this 

however, should not affect the encryption process, and has been fixed in version 

1.4.10). 

 

Encrypt the message (Albert Einstein‟s quote). 

 

Q3. There is an error in the following ciphertext representation of this  quote, what is 

it? 

 

SDAHFOWGRABSSRERIVBYBSCIMQTFNIVETGHBSNQCNCSDTDHBSNQCD

ECNICIFCTIC 

[1 mark] 

 

Q4. Of the three discussed ciphers (Caesar, Vigenère, Playfair), which is the most 

secure and why? 

[3 marks] 
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2.3 Lab 2: Advance Functions of the CrypTool 

Estimated time for completion 1 hour 

Available marks   10 

Specific Required reading  CrypTool Manual, 

     This Report: 

     1.5 Mathematical Principles 

     1.7 Modern ciphers 

 

Introduction 

The last lab looked into understanding the basic functions of CrypTool and how to 

use them. The aim of this lab is to demonstrate some of the more advance techniques 

CrypTool has to offer. 

DES 

CrypTool offers two variations of the DES cipher, electronic codebook (ECB) and 

cipher-block chaining (CBC), these are both known as block cipher modes of 

operation. As discussed in the report, DES breaks down a plaintext message into 64 

bit sized blocks, these are then converted to 64 bit blocks of ciphertext. 

Conventionally these ciphertext blocks have no relation to one another‟s encoding, 

this is the former of the two methods, ECB. There is however a weakness with this 

method, the DES encodes two identical plaintext blocks as two identical ciphertext 

blocks, in a message where there could be large repletion of a 64 bit block, say an 

image, this could reveal patterns in the ciphertext message and ultimately lead to it 

been deciphered. CBC is a method that overcomes this by combining each block 

with its preceding block with an exclusive-OR logic gate (like the Vernam cipher). A 

factor that can make this cipher at times impractical is that the whole message must 

be transmitted error free in order for it to be comprehensibly deciphered at the 

receiver side. With the ECB method an error in one block will only effect the 

deciphering of that one block and not the entire message. 



Cryptographic Techniques for Network Security 

 

-61- 

Using DES with CrypTool 

Open a new file and type a plaintext message or alternatively open the file 

examples/Startingexample-en.txt. Next click from the menu Crypt/Decrypt > 

Symmetric (modern) > DES (ECB)… This presents a key selection window, this 

key must be 64 bits long, which equates to 16 hexadecimal figures. For simplicity 

use the default key of: 

00 00 00 00 00 00 00 00   

Select Encrypt and there should be presented a window showing the data encrypted 

in hexadecimal form and its corresponding ASCII representation. To decrypt the 

message again select Crypt/Decrypt > Symmetric (modern) > DES (ECB)… Use 

the same key and select Decrypt, and the original message will be displayed in 

hexadecimal representation. Selecting View > Show as text displays it in ASCII; 

you may also notice some of the formatting is lost in the process  or some padding is 

added. 

 

Encrypt the same message using the same process as above only selecting 

Crypt/Decrypt > Symmetric (modern) > DES (CBC)… instead. Comparing the 

two encrypted messages, you should notice they start with the same 8 bytes, but then 

they are not the same but both are illegible.  

Comparison of ECB and CBC 

Now create a new plaintext file, choose a word and type it in, now copy and paste 

this word until there are about 100 repetitions. For the below example the word 

Cryptography was used: 
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Encrypt this first with the ECB variant of the DES cipher, there should be a notable 

pattern present (the word is 12 bytes long, 8 bytes form a block, all 3 blocks you see 

the same pattern): 

 

 

A pattern like this could potentially help a cryptanalyst decipher the data. Next 

encrypt the same message using the CBC method. 

 



Cryptographic Techniques for Network Security 

 

-63- 

 

 

As shown with the above example there should be no obvious pattern present making 

this a much stronger form of DES encryption. 

 

Q1. For each of the following say whether ECB or CBC would be most appropriate 

and give a brief explanation as to why. 

An online bank statement       [2 marks] 

An encrypted VoIP session       [2 marks] 

Viewing of a website using TCP/IP     [2 marks] 

 

ANIMAL 

As with the previous lab session, the DES cipher can be demonstrated with the aid of 

the ANIMAL Animator. Select Indiv. Procedures > Visualization of Algorithms > 

DES...  and watch through the whole demonstration. This should help to reinforce 

understanding of this cipher. 
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RSA 

A full explanation of the workings of RSA can be found within the report. The maths 

behind RSA is more complex than of the ciphers that these lab sessions have so far 

covered, and accordingly the CrypTool contains more tools that explore RSA than 

any other cipher. 

 

RSA demonstration 

Before actually implementing the cipher with example data, we shall first use a tool 

to demonstrate its workings. The demonstration material may be accessed through 

Indiv. Procedures > RSA Cryptosystem > RSA Demonstration… or 

Crypt/Decrypt > Asymmetric > RSA Demonstration… This presents a window 

with a series of options. 
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Make sure that the radius option of using p and q is selected, not the N and e option.  

 

Next we shall enter some prime numbers for p and q. As thinking of large prime 

numbers can be a daunting task, the CrypTool has included a prime number 

generator, this can be accessed by clicking the button Generate prime numbers… . 

Here make sure the option for independent values is selected. 

 

The algorithm used does not really matter as they all produce prime numbers. For 

the lower value of each we shall use 500, and for the upper value, 1000. It is worth 

noting here that these limits may also be entered in the form of binary length, using 

the notation 2^x where x is the number of binary bits used to represent a number.  
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Once all that has been completed click Generate prime numbers, and prime 

numbers will be generated, this may be clicked several times to generate different 

numbers. Select Apply primes and these will be entered as the values for p and q. 

The values for N and  will be automatically calculated. Now enter a value for e, 

this should be coprime to , if in doubt use a known prime number such as 13. 

Select input as text, and enter as the message you wish to be encrypted a word or 

phrase, and then select Encrypt. 

 

 

 

Highlight and copy the encrypted numbers, in the above example these are:  

284977 # 362822 # 328426 

Your encrypted values will likely vary. Change the input type to numbers, and paste 

these numbers into the message input box (remember to include the separators, #). 

Select Decrypt and you should see your original message deciphered. 
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Now, encrypt a message of your choice using the values:  

p = 59 

q = 71 

e = 13 

Observe the results. Encrypt the same message with the values:  

p = 673 

q = 619 

e = 13 

 

Q2. What difference do you notice in the block size, discuss whether or not this 

cipher would be susceptible to statistical analysis and why.  

[2 marks] 

 

RSA implementation 

Next we shall encrypt a message using PKI. PKI (Public key infrastructure) includes 

users‟ details in the encryption process as a form of authentication. 

 

Start by selecting Digital Signatures/PKI > PKI > Generate/Import Keys… This 

is where you can create a pair of asymmetric keys, one public and one private, using 

user details to do so. Here you may choose from three ciphers, RSA, DSA and 

elliptic curve. We shall use RSA, also, select a bit size of 512. Next, enter the user 

details requested on the right. Once all this has been done select Generate new key 
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pair… At this point you may be required to move the mouse so as the system has 

some data to generate a random input.  

 

 

 

Select Apply. You have just generated an asymmetric key pair. To view this key and 

any other asymmetric keys that have been generated select Digital Signatures/PKI 

> PKI > Key Display/Export Keys… This can also be used to view the details of 

each key and to delete them if needed. 

 

Now that an asymmetric key pair is available you may encrypt/ decrypt data using 

the RSA cipher. Open a new text file with the CrypTool and enter some text you 

wish to encipher. Select Crypt/Decrypt > Asymmetric > RSA Encryption… Select 

the line with your newly created key and then press Encrypt. The encrypted form of 

the text should appear. 

 

Q3. Analyse the data encrypted with the RSA cipher. How does this encryption 

method compare to the other methods these Labs have covered?  

[2 marks] 

 

The encrypted data may be deciphered in a similar manner to other ciphers. Make 

sure the encrypted data window is active, then select  Crypt/Decrypt > Asymmetric 

> RSA Decryption… Select your key and PIN, then press Decrypt. 

 

Your message should be displayed but will likely have all the HEX representation 

shown as well 
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To remove the hexadecimal representation and display the message in a more human 

legible way, select View > Show as Text, and should you wish to revert to the 

hexadecimal view select View > Show as HexDump. 

 

Hybrid encryption 

The last cipher we will look into in this second lab session is the hybrid cipher, this 

combines aspects of both the AES and RSA ciphers. To encrypt a message with it, 

select Crypt/Decrypt > Hybrid > RSA-AES Encryption…  Then a GUI will be 

presented: 
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This display is very effective as it demonstrates the processes of this cipher in a very 

easy to understand way. 

 

Begin by clicking on the Generate session key button, you may be asked again to 

move the cursor for random input. Once successfully completed this button should 

turn green and the session key generated. Click on the Select asymmetric key 

button and choose the key you made during the RSA encryption. Click on the 

remaining two red boxes, and select Save. You should now see your data encrypted 

with the hybrid cipher. To decrypt it select Crypt/Decrypt > Hybrid > RSA-AES 

Decryption…. At this dialog select Continue, then select the PSE (Personal 

Security Environment) with the appropriate private key and enter the PIN number of 

the PSE to open it. Selecting Continue once more, you can see the RSA private key 

used to encrypt the AES session key, and then press Decrypt. You should now have 

a comprehensive understanding of the methods of encryption available and how to 

deploy them using the CrypTool. 
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2.4 Lab 3: Cryptanalysis 

Estimated time for completion 1 hour 

Available marks   13 

Specific Required reading  CrypTool Manual,  

     This Report: 

     1.3 Cryptanalysis 

     1.5 Mathematical Principles 

 

You should now be acquainted with the CrypTool, and experienced in the methods 

used for encrypting and decrypting data. In this final lab session we shall explore the 

field of cryptanalysis, using the knowledge gained from the previous labs to reveal 

encrypted data. 

 

To begin we shall observe some of the methods used to intercept data transmissions. 

Select Indiv. Procedures > Protocols > Network Authentication… You will see a 

network setup, to the left are a series of five challenges and an introduction, we shall 

begin with the Introduction. 
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Read through the description given in the terminal and complete each of the tasks. 

This tool offers a hypothetical network in which you act as an intruder. You are 

given a degree of autonomy over the networks topology, where you may create or 

delete links between nodes or get control over routers, from this you are to devise a 

method of authenticating the attacking station with the server. The level of difficulty 

increases accordingly, the harder the scenario the more advance the security 

techniques used. Complete each of the scenarios in turn and, if at any point you are 

unable to complete a task or do not understand an aspect of it, refer to the 

CrypTool‟s extensive help files by pressing F1. 

 

Once these scenarios have been completed, you should have a clear idea as to the 

methods one would use to infiltrate a network. Next we shall explore the methods a 

cryptanalyst would use to decipher this newly obtained information.  
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Q1. Rate the following cascading ciphers combinations in order of effectiveness, 

starting with the most effective (You may use the CrypTool to help you if you wis h). 

[3 marks] 

a) Rail fence - Caesar  

b) Caesar - DES 

c) Caesar - Rail fence – Caesar (Different key to original Caesar encryption) 

d) Caesar - Rail fence - Atbash 

 

 

Q2. 1963497163 is the product of two prime numbers, use tools within the CrypTool 

to find these two prime numbers. Mention what tool(s) you used to do this.  

[2 marks] 

 

 

Q3. You have been assigned the task of designing a tool for CrypTool to do the 

above equation, break a number down into two prime number factorials. Give a brief 

description of your algorithm and include an example.  

[4 marks] 

 

 

 

Below is some Ciphertext 

 

Iye rkfo tecd cemmoccpevvi nomszrobon drsc Mkockb oxmbizdon wocckqo, govv 

nyxo. 

Cipertext 1 

 

The first observation we can make is that the grammar is still intact, and so we need 

not adjust the text options. Analyse the text, make special note of the histogram 

results (There is a comprehensive guide to the analysis tools under the chapter 2.1 

Lab Sessions \ CrypTool Manual): 
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Due to the frequency displayed with these results we can deduce that the cipher is a 

relatively weak one, most likely a substitution cipher. If we were to manually 

decipher this message we could do so by observing O is the most prevalent 

character, and so is likely a representation of the letter E. Assuming the cipher is the 

Caesar cipher we would then know the key is J. Applying this to the rest of the text 

reveals the message: 

 

You have just successfully deciphered this Caesar encrypted message, well done.  

Plaintext 1 

 

As this makes sense we know that the text was in fact encrypted with the Caesar 

cipher using the key J, should this have not made sense we could have further 

analysed the text. To demonstrate some of the functions of the CrypTool, select the 

ciphertext 1 and select Analysis > Symmetric Encryption (classic) > Ciphertext 

only > Caesar using this, the key can be deduced and the message decrypted.  

 

 

Q4. What is the plaintext form of: 

1.1. Jfu ih ghltk - Yc bbhcqusrmwcy vf AgrdHzqc 

     ------------------------------------------  

Uwxb mzw jrpkh ia EiweMccw, vyc RkmdEqfj lhfy ltvy hmofeu ln 

pecbr yzrw t galnc uteqcxg jagxsb hjzaw tddpciq xg hvp 

hfptzfcfpu. Gu rci atvqh Y1 wb ejv uteqcxg jagxsb, ejv qitfhtpx npzs  

cq vyc dgzwyg ycai qcxgj se mcc. 
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Ejzq hmofekee etus tu r edhr gecirxgu dzker, ih psnqdc pveilkertw 

kwej rja xggppkgpe tslvlptl ct NtpnIhcz (fuzlv mvs wkeih hb hskj  

qitfhtpx npzs). Dwgrqt ksoo vyc xgtccorrxhb oyf kft awbeu fl ias  

wyvimsnqhztp fted dliv. 

 

Rd jiwnmcw vxh ia vf qexsr zp tpnihcrtrnwr kwej TpniHczn, nc  

gxqcxovls mvoe afs lhfy ejimjzv gzov mu mvs pzrkeesg (ewkmgbozd) 

rimkbrso yzrwbb hsg flabbs sgcn utqwwkkw (ias sicdnaxg ocg jfdpb 

wy vyc dgzwyg ycai qcyvvlil cjptmgtp ibogi "Qitfhtpx udky ktvy 

AgrdHzqc"). 

 

Rwx sodkvqi pom eq kpn hih xcew dy hvp EiweMccw hllrmwcyu zq lbhv  

ejv dxes "Gecirxgusicdnax-sb.ezk", uwbqv tu fntg pm ogwyjeh wy vyc 

RkmdEqfj lhfy ltvy. Qnh mzw rjhh qoy qgcc tbm fpvlrkmdegu dxes tcqd rwx  

"sllogjtl" gimfzptvhcca fp pgm cejvp ubzs.  

 

Th r ktgi wegd fpl bc xgrlxgu hz afs dk mcf ffl'i dbch goyrmzm hjrr  

ih rc hkkfxg o rtccmv pwboqn, naxogp richl T1. Wq vyc pvqccfzlv 

hbztpv fted wdp'k qpmwgqctrdkm dwgrqt zwjp wj dtxrpleb.  

 

Wdn qoy hzls t 1-dorg fttkjwpy fttk ozw ovljl wb NtpnIhcz (xges ikss)  

hkkfxg hvp keaanrso RUD hvfwav (jct tddppugm T1).  

 

Ks sqgc nhi sylfw axofykee pucie eiwemcuccgfn tbr etpgcz cie ccj ias 

tfptrxhbowkkw lbhvtp TpniHczn. 

 

[2 marks] 

 

 

Q5. What is the plaintext form of: 

KIRIAGANOTGFPUOPNUCDPOFIHLVQZDCOMWNKDOUPMIDFCRDFLZ 

BNPZZSNBNBQGZMIMCROCKCTITMDFAWWXAHCAIGEBCPASKRNB 

 [2 marks] 
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Document Overview 

3.0 CrypTool Review 

Analysis of the CrypTool 

Having used the CrypTool extensively with this project I have come to see many of 

its strengths and weaknesses. The CrypTool is very flexible and easy to use, making 

it ideal for teaching people about cryptography, it also contains several 

demonstration examples that are designed to be very easy to follow, and break down 

the mathematics into small manageable steps. Personally I have found this to be a 

huge benefit and am sure that it would also prove to be for other students eager to 

learn about cryptography. 

 

The CrypTool is free and open source, as it is primarily for educational value this 

holds obvious advantages, however there are disadvantages too. Being free means 

that there is not as much money available for the project as there would be for say a 

commercial product (The CrypTool is however sponsored by several banks and 

businesses, and students and researchers participating and exchanging knowledge). 

This in mind, there is only a relatively small number of permanent programmers 

dedicated to its development. Consequently I have noticed the occasional glitch in 

the software, one in particular which I encountered was with the Playfair cipher. 

Here the Playfair square displayed in version 1.4.00 inaccurately the key phrase (the 

third line was moved to the fifths line): 
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I emailed the CrypTool staff about this problem, and they replied swiftly, thank ing 

me for the observation, and promptly fixed it for the next release (now 1.4.10). So 

despite the occasional glitch there, CrypTool has a very friendly, prompt and 

efficient support base who are eager to spot and correct errors.  

 

Overall I would rate the CrypTool very highly, it is an excellent tool for educating 

users in the field of cryptography and it is rare a tool of such quality is freely 

available. 

Comparison to rival products 

In competition to CrypTool there are several products. There are many rivals on the 

market that will encrypt a message, some of which for free, but none of which 

educate users and none comprise of such a vast collection of tools in one package.  

 

This makes CrypTool somewhat unique: It is the only product available that includes 

such an array of tools relevant to cryptography and that‟s prime purpose is to 

educate the user. So it is a rare quality that CrypTool is available freely and as open 

source, making it the ideal choice for education. 
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Expandability 

CrypTool is open source, and that means that anyone can see its working and alter 

them as they see fit. Consequently CrypTool is very easily expanded, the structure of 

the code itself has been written in a very logical manner, and adds simplicity by 

using object orientated principles (it is written in C++). Names of classes, methods 

and variables are all self explanatory (for example PlayfairAnalysis.cpp) and all the 

code is extensively annotated. All of this makes the code extremely easy for a 

programmer to add to, and far easier than writing a whole new program from scratch 

to demonstrate one cipher. 

The biggest disadvantage of the current C++ code base is that new developers also 

have to know how the kernel and the GUI work. In the future versions, CrypTool 2.0 

(written in C#), and JavaCrypTool (written in Java), this will be handled via 

interfaces: So a new developer can concentrate on developing a new algorithm e.g. 

within a plugin. And the plugin tells the framework via defined interfaces how to 

load it, how to show it, how to store keys etc. Beta releases for these future versions 

are planned for 2008. 

The current C++ release is still supported, release 1.4.2x of the next C++ release is 

planned for mid 2008. 
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Notable websites 

 

www.cryptool.org 

The site that hosts the CrypTool, also contains a great deal of information on the 

software, including screenshots, demonstrations and the source code. 

 

www.microsoft.com/security 

This site contains an excellent resource of information keeping you up-to-date with 

the latest security reports. 

 

www.rsa.com 

Maintained by the RSA laboratories, this site contains information on RSA and 

several other modern day ciphers. 

 

www.schneier.com 

This site is maintained by the author Bruce Schneier  and contains a wealth of 

information in the field of cryptography from essays about the state of world 

security and ID cards to a breakdown of several encryption algorithms. 
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www.theregister.co.uk 

A great resource with several interesting and relevant articles . 

 

www.tropsoft.com 

Although the sites primary purpose is to sell security products it has some very 

useful descriptions of common modern ciphers. 

 

www.wikipedia.org 

The nature of this site means that any one with any motives or experience may edit 

the content and so it can sometimes be misleading or inaccurate. Despite this 

however, I found this a site a valuable resource, not for the text content but instead 

for the images it contained, the majority of these have open copyright laws and so I 

have used some throughout this document (all are referenced). The other aspect of 

this site I have found very useful is the references it contains, I have used wikipedia 

extensively to find other source material.  



Cryptographic Techniques for Network Security 

 

-82- 

3.2 Appendices 

Model answer sheet 

3.2.1 Lab 1: Introduction to Cryptography and CrypTool  

 

Q1. Which tool or technique would be most effective for a cryptanalyst to use to 

decipher a text encrypted with the Caesar cipher, and why? 

[3 marks] 

Answer 

In this case the histogram would offer the most valuable information to a 

cryptanalyst. The Caesar cipher‟s primary weakness is that to statistical analysis 

which this tool clearly demonstrates. From the tools findings it is very easy to 

compare the prevalence of each letter of the ciphertext to the prevalence of letters in 

the English language, from this conclusions can easily be made as to what characters 

are used to substitute each letter.  

 

Breakdown 

1 mark for identifying the histogram as the best suited tool  

2 marks for an accurate explanation 

 

 

Q2. What do you notice about the histogram results when text is encrypted with the 

Vigenère cipher in comparison to the results of the Caesar cipher? Why is t his the 

case? 

[3 marks] 

Answer 

The results appear a lot more randomised, they would harder to draw conclusions 

from than the Caesar cipher. This is the case as Vigenère cipher uses a form of 

modified Caesar cipher to encrypt data therefore a letter‟s representation can change 

throughout the course of the message. The histogram measures the prevalence of 
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individual characters. These individual characters however do not directly correlate 

to the original text as they do with the Caesar cipher.  

 

Breakdown 

1 mark for an accurate relevant observation regarding the histogram results  

2 marks for mentioning modified Caesar cipher or saying how a characters 

representation can change 

 

 

Q3. There is an error in the following ciphertext representation of this  quote, what is 

it? 

 

SDAHFOWGRABSSRERIVBYBSCIMQTFNIVETGHBSNQCNCSDTDHBSNQCD

ECNICIFCTIC 

[1 mark] 

 

Answer  

The cipher text should be 

SDAHFOWGRABSSRERIVBYBSCIMQTFNIVETGHBSNQCNCSDTDHBSNQCD

ECNICIFOTIC 

There was a miscalculation  

SDAHFOWGRABSSRERIVBYBSCIMQTFNIVETGHBSNQCNCSDTDHBSNQCD

ECNICIFCTIC 

 

Breakdown 

1 mark for correctly identifying the error 

 

 

Q4. Of the three discussed ciphers (Caesar, Vigenère, Playfair), which is the most 

secure and why?          [3 marks] 

Answer 

Vigenère. The Playfair cipher is a substitution cipher for digrams, the Caesar cipher 

substitution cipher for single characters and so both are susceptible to statistical 



Cryptographic Techniques for Network Security 

 

-84- 

analysis. The Playfair cipher is in effect a substitution cipher that uses a much larger 

alphabet (26*26) than the Caesar cipher. Both are mono-alphabetical substitution 

ciphers. In contrast, the Vigenère cipher is a poly-alphabetical substitution cipher, so 

it changes what values are used to represent each character and so is stronger.  

 

Breakdown 

2 marks for choosing the Vigenère cipher 

1 mark for choosing the Playfair cipher 

1 mark for accurate explanation 

 

3.2.2 Lab 2: Advance Functions of the CrypTool 

 

Q1. For each of the following say whether ECB or CBC would be most appropriate 

and give a brief explanation as to why.  

 

a) An online bank statement       [2 marks] 

Answer 

CBC. For information of this nature security is a primary concern and CBC is the 

more secure of the two methods and so should be implemented.  

 

Breakdown 

1 mark for CBC 

1 mark for any mention of the increased security provided by CBC in comparison to 

ECB 

 

b) An encrypted VoIP session       [2 marks] 

Answer 

ECB. VoIP uses connectionless protocols and as such can not guarantee that packets 

will be received in ordered or received at all. Consequently, using CBC would be in 

appropriate as it is dependant on the ordering of blocks.  

 

Breakdown 

1 mark for ECB 
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1 mark for any mention of the ordering of blocks been of importance  

As this project is specific for cryptography of networks, it is assumed the student 

understands the principles behind connection orientated and connectionless 

protocols. 

 

c)Viewing of a website using TCP/IP      [2 marks]  

Answer 

CBC.  TCP/IP ensures packet delivery in order, as such there is no advantage in 

using ECB, CBC should be used for the added security.  

 

Breakdown 

1 mark for CBC 

1 mark for mentioning the added security of CBC and no extra benefit using ECB  

 

 

Q2. What difference do you notice in the block size, discuss whether or not this 

cipher would be susceptible to statistical analysis and why.  

[2 marks] 

Answer 

The block size is dependant on the key values used to encrypt the data. For this 

reason the key should be long enough that a cryptanalyst would be unable to perform 

any meaningful statistical analysis. Using the RSA encryption the block size only 

depends on the value of n. 

Taking the two RSA samples (p=59, q=71) and (p=673, q=619), and using b-adic 

encoding and an alphabet of 256 characters, 

we get (n=4189; max block length=1) and (n=416587; max block length=2).  

Encrypting binary data, then in case one only 256 different values can appear; in 

case two 256^2 different values can appear (because RSA works as a kind of 

monoalphabetic substitution for the numbers of each block).  

 

Breakdown 

2 marks for accurate explanation 
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Q3. Analyse the data encrypted with the RSA cipher. How does this encryption 

method compare to the other methods these Labs have covered?  

[2 marks] 

Answer 

Encryption with the RSA cipher is far more secure than the classic ciphers. Entropy 

values for RSA encrypted data tend to be extremely high, almost at the maximum 

value; histogram results appear randomised; and N-gram analysis is meaningless. 

Encryption with RSA and with modern symmetric ciphers can have the same level of 

security; the level depends only on the length of the used key. The performance of 

RSA is slower than e.g. AES. 

 

Breakdown 

2 mark for mentioning of analysis tools and a brief explanation  

 

 

3.2.3 Lab 3: Cryptanalysis 

Q1. Rate the following cascading ciphers combinations in order of effectiveness; 

starting with the most effective (You may use the CrypTool to help you if you wish)  

[3 marks] 

 

a) Rail fence - Caesar  

b) Caesar - DES 

c) Caesar - Rail fence – Caesar (Different key to original Caesar encryption) 

d) Caesar - Rail fence - Atbash 

 

Answer 

1)B 

2)D 

3)A and C (both equal)  

 

 

Breakdown  
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1 mark for recognising B as the most effective super cipher  

1 marks for identifying A and C as equal  

1 mark for identifying A, C or both together as the least effect combination  

 

NOTE: A and C are considered equal as running the Caesar cipher twice (or even 

multiple times) has the exact same effect as running it once with a different shift 

key. The fact that two different shift keys are used has no bearing on breaking the 

encryption when using statistical analysis to decipher. 

 

 

Q2. 1963497163 is the product of two prime numbers, use tools within the CrypTool 

to find these two prime numbers. Mention what tool(s) you used to do this.  

[2 marks] 

Answer 

57881 and 33923,  

Indiv Procedures > RSA Cryptosystem > Factorisation of a number 

This can also be found through: 

Indiv Procedures > RSA Cryptosystem > RSA Demonstration 

   (selecting the radio button for using only the public key).  

 

Breakdown 

1 mark for the two numbers 

1 mark for the correct identification of a CrypTool tool. 

 

 

Q3. You have been assigned the task of designing a tool for CrypTool to do the 

above equation, break a number down into two prime number factorials. Give a brief 

description of your algorithm and include an example.  

[4 marks] 

Answer 

Take the result number and divide it by each prime number that is less than the 

square of it in turn. If the result is an integer prime number the key fair has been 

found. For example 
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77 is the product of two prime numbers 

77/2 = 38.5   no 

77/3 = 25.666  no 

77/5 = 15.4   no 

77/7 = 11  yes 

 

Breakdown 

3 mark for a working algorithm 

1 mark for an accurate example 

 

 

Q4. What is the plaintext form of: 

1.1. Jfu ih ghltk - Yc bbhcqusrmwcy vf AgrdHzqc 

     ------------------------------------------  

Uwxb mzw jrpkh ia EiweMccw, vyc RkmdEqfj lhfy ltvy hmofeu ln 

pecbr yzrw t galnc uteqcxg jagxsb hjzaw tddpciq xg hvp 

hfptzfcfpu. Gu rci atvqh Y1 wb ejv uteqcxg jagxsb, ejv qitfhtpx npzs  

cq vyc dgzwyg ycai qcxgj se mcc. 

 

Ejzq hmofekee etus tu r edhr gecirxgu dzker, ih psnqdc pveilkertw 

kwej rja xggppkgpe tslvlptl ct NtpnIhcz (fuzlv mvs wkeih hb hskj  

qitfhtpx npzs). Dwgrqt ksoo vyc xgtccorrxhb oyf kft awbeu fl ias  

wyvimsnqhztp fted dliv. 

 

Rd jiwnmcw vxh ia vf qexsr zp tpnihcrtrnwr kwej TpniHczn, nc  

gxqcxovls mvoe afs lhfy ejimjzv gzov mu mvs pzrkeesg (ewkmgbozd) 

rimkbrso yzrwbb hsg flabbs sgcn utqwwkkw (ias sicdnaxg ocg jfdpb 

wy vyc dgzwyg ycai qcyvvlil cjptmgtp ibogi "Qitfhtpx udky ktvy 

AgrdHzqc"). 

 

Rwx sodkvqi pom eq kpn hih xcew dy hvp EiweMccw hllrmwcyu zq lbhv  

ejv dxes "Gecirxgusicdnax-sb.ezk", uwbqv tu fntg pm ogwyjeh wy vyc 

RkmdEqfj lhfy ltvy. Qnh mzw rjhh qoy qgcc tbm fpvlrkmdegu dxes tcqd rwx  
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"sllogjtl" gimfzptvhcca fp pgm cejvp ubzs.  

 

Th r ktgi wegd fpl bc xgrlxgu hz afs dk mcf ffl'i dbch goyrmzm hjrr  

ih rc hkkfxg o rtccmv pwboqn, naxogp richl T1. Wq vyc pvqccfzlv 

hbztpv fted wdp'k qpmwgqctrdkm dwgrqt zwjp wj dtxrpleb.  

 

Wdn qoy hzls t 1-dorg fttkjwpy fttk ozw ovljl wb NtpnIhcz (xges ikss)  

hkkfxg hvp keaanrso RUD hvfwav (jct tddppugm T1).  

 

Ks sqgc nhi sylfw axofykee pucie eiwemcuccgfn tbr etpgcz cie ccj ias 

tfptrxhbowkkw lbhvtp TpniHczn. 

 

[2 marks] 

 

Answer 

 

Vigenère, Key: CRYPTOOL  

 

1.1. How to start - An introduction to CrypTool 

     ------------------------------------------  

When you start up CrypTool, the CrypTool work area starts up  

along with a small welcome screen which appears in the 

foreground. If you press F1 in the welcome screen, the starting page  

of the online help comes up too. 

 

This starting page is a good starting point, to become acquainted  

with all essential features of CrypTool (using the links on this 

starting page). Please read the information and the hints on the  

introductory help page. 

 

To quickly get up to speed on cryptography with CrypTool, we  

recommend that you work through some of the examples (tutorials)  

provided within the online help facility (the examples are shown 
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in the online help contents overview under "Starting work with  

CrypTool"). 

 

The easiest way to try out many of the CrypTool functions is with  

the file "Startingexample-en.txt", which is open by default in the 

CrypTool work area. But you also can open any unencrypted file from the  

"examples" subdirectory or any other file.  

 

If a menu item has no meaning to you or you don't know exactly what  

to do within a dialog window, please press F1. If the according 

online help isn't satisfactory please give us feedback.  

 

You can find a 1-page overview over all menus in CrypTool (menu tree)  

within the included PDF script (see appendix A1).  

 

We hope you enjoy learning about cryptography and trying out all the  

functionality within CrypTool. 

 

Breakdown 

2 marks for correct decipherment 

 

 

Q5. What is the plaintext form of: 

KIRIAGANOTGFPUOPNUCDPOFIHLVQZDCOMWNKDOUPMIDFCRDFLZ 

BNPZZSNBNBQGZMIMCROCKCTITMDFAWWXAHCAIGEBCPASKRNB 

[2 marks] 

Answer 

Playfair, Key: MARKTWAIN 

A banker is a fellow who lends you his umbrella when the sun is shining, but wants 

it back the minute it begins to rain.  

 

Breakdown 

2 marks for correct decipherment 
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MARK Calculation 

 

To derive the mark, add all the lab marks together, multiply by 3 and add 1 to get a 

percentage mark. An example is 

Lab1:   7/10 

Lab2:   5/10 

Lab3:   9/13 

TOTOAL: 21/33 

 

21 * 3 = 63 

+1 = 64 

Student got 64% 

 


